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Foreword

First, allow us to express our thanks that you have decided on this product. We wish you total success in
accomplishing your measurement assignments with the help of the imc hardware and software.
If there are any open questions about our products, please contact our Hotline (hotline@imc-berlin.de).

Disclaimer of liability

The contents of this documentation have been carefully checked for consistency with the hardware and
software systems described. Nevertheless, it is impossible to completely rule out inconsistencies, so that
we decline to offer any guarantee of total conformity.

We gratefully accept any suggestions for improvements, please contact our Hotline (hotline@imc-
berlin.de).

We reserve the right to make technical modifications of the systems.

Copyright
© 2016 imc Mel3systeme GmbH, Berlin, Germany

This documentation is the intellectual property of imc MelRRsysteme GmbH. imc MeRsysteme GmbH
reserves all rights to this documentation. The applicable provisions are stipulated in the "imc Software
License Agreement".

The software described in this document may only be used in accordance with the provisions of the "imc
Software License Agreement".

imc Software and Microsoft® Windows

imc software runs on the Microsoft® Windows operating system. Microsoft Windows provides a
standardized user interface for imc software and all other Windows-applications.

A license for the respective version of Microsoft Windows is required.

Microsoft, MS and MS-DOS are registered trademarks and Windows is a trademark of Microsoft
Corporation.

Intel and Pentium are registered trademarks of Intel Corporation, USA.

All other trademarks are the property of their respective companies.

GPL Sources

Some components of our hardware use software, that is licensed under GNU General Public License
(GPL). If you would like a copy of the GPL source code contained in this product please contact the imc
Hotline.
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Imc STUDIO Version 5.0R3 build December 15, 2015
1 Firmware and new hardware

This imc STUDIO version has been released along with the following versions of the firmware

(imc DEVICES). Please check regularly whether any new firmware versions are available and perform an
update if your version of imc STUDIO supports the new firmware. Further information can be obtained
from the imc Hotline.

1.1 Firmware 2.8R7 SP1 dated December 14, 2015

Field bus - Flexray

Import and export of Flexray configuration are now possible by COM-Interface.
imc HiL

imc HiL supports Matlab R2015b.

Balancing and 2-point-scaling

Taring and bridge balancing during a running measurement is not possible if the channel had already
been scaled by means of 2-point scaling.

2 Widgets

Widgets: Automotive, Industrial, Designer
Displaying variables’ individual bits
Selected Widgets now offer the option of only displaying individual bits in a variable. Example: A
fieldbus channel returns multiple channel states with:
¢ Oth bit: Sensor connected
o 1st bit: Value exceeded
e 2nd bit: Error

With the new property: "Bitmask",it is now possible to select which bit to display. If the 1st bit is
selected, the Widget only shows the value of the 1st bit. Thus, with status indicators on the Panel
page, it is easy to present an overview of the status of the various channels.

3 Data Browser

Automatic re-loading of measurements

imc STUDIO automatically detects when a .dat or .raw file is copied to a measurement folder. If the
measurement is already loaded, a "re-load" operation is automatically initiated. Thus, the file also
appears in the Data Browser.
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4 Scripting

Operations modified
e There is now more information in the logbook regarding the sender when a script run malfunctions.
e When a faulty script is run, the script name and any compiler message are included in the logbook
entry.

5 Update Notes

Revisions of the menu ribbon regarding user guidance:

e The names of some buttons have been elaborated (z.B: Project > Manage -> Project > Manage
Projects or View > Reset -> View > Reset Workspace Layout)

¢ New groups have been added (e.g.: Project > Im-/Export and Project > Measurement Data)
¢ Buttons have been moved (e.g. User-defined buttons has been moved from Extra to View)

¢ Buttons have been duplicated (e.g. Panel Fullscreen Mode is now also found under Panel-Design or
all fieldbus assistants and the Displayeditor are now also found under Home if the device has the

modules)
The structure of the menu ribbon is saved with the view. This means:

¢ Upon first installation, the changes are applied automatically when there is no database available.
e When updating or when using an existing database, the changes are not applied automatically.

Automatic adoption of the new view
To apply the changes, you need to reset the views to the factory settings.

Ribbon View
Extra > Restore () Compact, Standard
View > Restore (&) Complete

‘1, Warning: Everything will be reset

This means not only the menu ribbon will be reset but also all Setup pages, the window arrangements
and the columns displayed in the tool windows (e.g. in the Data Browser).

User-created columns, such as metadata columns, are no longer displayed. The configuration of these
columns remains intact. You can insert these columns back at the desired position (by means of the

column selection).

Manual adoption of the new view
If you do not wish to reset this view, you can adjust the changes manually.

Ribbon View
View > Customize Ribbon Menu (@) Complete

'@ Note

The changes to the menu ribbon do not include any new functions, but are only for the purpose of
improved user guidance. The manual adoption by modifying the menu ribbon is not necessary.
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imc STUDIO Version 5.0R3

1 Firmware and new hardware

This imc STUDIO version has been released along with the following versions of the firmware

(imc DEVICES). Please check regularly whether any new firmware versions are available and perform an
update if your version of imc STUDIO supports the new firmware. Further information can be obtained
from the imc Hotline.

1.1 Firmware 2.8R7 dated August 26, 2015

1.1.1 Hardware

CRFX/AUDIO2-4-MIC
Support of the new CRFX/AUDIO2-4-MIC with a supply module for microphones.

CRFX/FRQ2-4
Support of the new CRFX/FRQ2-4.

CRFX/1SOF-8
Updated low pass filter:
Firmware up to 2.8R5 Firmware as of 2.8R7
50 Hz to 20 kHz 10 Hz to 20 kHz

CRFX/ICPU2-8
Passive channels configured as "AC with current feed" no longer output a current.

CRPL/CRC/HRENC-4
¢ The HRENC-4 signal delay has been reduced down to 1 ms.

o CRONOScompact/HRENC-4
Firmware implemented with accelerated data throughput for PV-variables.

1SO2-8
e PT1000: Support of PT1000 has been implemented for special hardware versions of the ISO2-8.

e CRPL/ISO2-8
With CRONOS-PL I1SO2-8, a +/-12V bipolar sensor supply by means of a characteristic curve file is
now possible.

SYNTH-8
e The controllers can be renamed.

¢ In Frequency Generator mode, Synthesizers only display outputs which can be supported. If the
Synthesizer is not able to support the Frequency Generator mode, then this mode will not be
displayed.

e Error messages now also contain the name of the device and the slot number.
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Sensor characteristic curves

Support of sensor characteristic curves is now enabled for following devices:

Amplifier/ CRPL/SL Firmware CRC Firmware CRFX Firmware
Device

ICPU-8 ° 2.7R3

DCB-8 ° 2.7R3

LVv2-8 ° 2.7R3

UNI-8 ° 2.7R3

1SO2-8 ° 2.7R3 ° 2.7R3 ° 2.8R5
UNI-4 ° 2.8R7 ° 2.7R3 ° 2.8R5
SC2-32 ° 2.7R3 ° 2.7R3

ICPU2-8 %) ° 2.8R7 ° 2.8R5
UNI2-8 %] ° 2.8R7 ° 2.8R5
DCB2-8 %) ° 2.8R7 ° 2.8R5
LV3-8 %] ° 2.8R7 ° 2.8R5
Device Feature Firmware
Cx-41xx-N ° 2.8R7

SPAR-U ° 2.8R7

e. Feature supported
@: Feature currently not supported

---: Amplifier not available for this device series

imc STUDIO 3.0R4 included firmware 2.7R3

imc STUDIO 4.0 included firmware 2.8R3

imc STUDIO 5.0R1 included firmware 2.8R5

imc STUDIO 5.0R3 included firmware 2.8R7
UPS

The device preforms a check the UPS and reports any defects upon connection.

1.1.2 Field bus

CAN-Bus
e CAN, OBD-2:
e When the functional identifier 18db33f1h is set up as "ID for tester", all replies with identifiers
from 18daf100 up to 18daflfd are used. (ISO 15765-4 6.3.2.3).

¢ Replies to the broadcast identifier 7DFh were not used when only a OBD-2 ECU was configured
for the CAN node. The replies are used now.

e For nodes with format Extended on the Validity tab a new option had been added: IBC node
adressing mode. If selected, the Channel bit, the Source bit, the Lifesign bits and the Telegram CRC
bits are ignored (masked) when receiving and evaluating messages.

e ECU: As an additional file format for ECU seed/key algorithms .skb files may be used now.
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LIN-Bus
Duration of MasterBreak in Bit-times: from 13 to 15; and bit-times of 1 to 3 for the
MasterBreakDelimiter is now adjustable.

SPI
Support of SPI fieldbus modules had been implemented.

1.1.3 imc WebServer

WebServer-configurations can now be exported and imported with the WebDesigner.

1.1.4 imc Application module
The following baud rates can be used with the serial interface variant (APPMOD-COM interface):

1200, 2400, 4800, 9600, 14400, 19200 and 28800.

1.1.5 imc HiL
imc HiL supports Matlab R2014a, Matlab R2014b and Matlab R2015a.

o imc HiL Simulink blocks (imcXPCLib*) are converted to the sIx-format upon configuration in MATLAB.
Resetting a model's status (reconfiguration in imc STUDIO) is performed by mens of the UserModel/
Enable-block. This block must be set to the parameter value "reset states when enabled".

2 General Changes in imc STUDIO

Menu actions

In alternative to the menu action "Panel Fullscreen Mode", there is now a menu action "Panel
Embedded View" for the purpose of exiting the fullscreen.

Options
¢ To provide a better overview, the imc STUDIO Options window now shows whether the respective
option is saved with the project or the application.

¢ The option: "Synchronize always" (Setup > Virtual device clock) has been eliminated. The virtual
device clock could previously be activated when synchronization between the PC and the device
was required. Now, the data pool always synchronizes with the device, consequently the option
"Synchronize always" is no longer needed.

¢ General options > Default dialog response: Additional dialogs have been added for which responses
can be specified.
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Placeholder
¢ Using the placeholder "PROPS", it is now also possible to call user-defined properties.

¢ The placeholder "EXPERIMENT.PATH" normally returns the experiment's "root path" in imc STUDIO.
This is where , for example, config, Meta and all measuremet folders are located.
By contrast, if the component "Project Management" is not activated (as is the case in
imc STUDIO Monitor), then the placeholder had previously not returned any result. Now the path of
the configuration file .imcStudio/.imcExp is returned when "Project Management" is deactivated.

e SQL-Placeholder: Column identifier with spaces in the name can now be resolved. However, for that
purpose an alteration of the syntax was necessary. More information on this topic is available in the
chapter: Update Notes > SQL Placeholder 23\

¢ When specifying the format of the placeholders CONTROLS, VAR, VARS, it is possible to specify
decimal separators.
e.g. <VARS["DisplayVar_01"].VALUE(*"0,000")> returns: 123,456
e.g. <VARS["DisplayVar_01"].VALUE("0.000")> returns: 123.456
Menu ribbon
The menu ribbon can now be customized with large icons. In the customizing procedure, the size of
the icons can be selected.
Parametersatz export und import

XML is now available as a format.

Installation/Product Configurator

Following an imc STUDIO update, as many settings from the previous product configuration as
possible are applied.

3 Setup and Device Control

Parallel use of multiple firmware versions

Manual selection of the desired firmware has been implemented. After selecting a device, e.g. for a
new experiment, a selection list appears. Here, you can select with which firmware version to set the
experiment up, if multiple versions are installed.

Experiments which have been created with a newer device firmware version can be loaded

When an experiment which had been created with a newer device firmware version was loaded, the
corresponding device was de-selected. This is now no longer the case. All settings possible are
retained and a warning message is posted accordingly.

Bridge balancing and taring

It is now possible to perform bridge balancing or taring during a running measurement. It is no longer
necessary to stop a measurement for that purpose.
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New column: Enumerated channel number

The column: "Connector"” does not correspond to the consecutive numbering on the front panel for
some devices (e.g. imc SPARTAN and imc CRC). An additional optional column is available, which
matches this numbering: "Enumerated channel number".

Marne « | Conneckor  « |Enumerated channel number
v Channel type: Analog inputs (Count=24)
Channel_001 [01] IMO1 TMOO1
hannel_002 [01] TMDZ MO0z
Channel_003 [01] IMO3 TMOO3
hannel_004 [01] TMD4 MO0
Channel_005 [01] IMOS TMOOS
hannel_00& [01] TMD& TMODE
Channel_007 [01] IMO7 TMOO7
hannel_00S [01] TMOB TMODS
Channel_009 [02] THO1 MO0
hannel_010 [02] TMDZ TMO10
Channel_011 [02] T3 HO11
hannel_012 [02] TMOD4 N1z
Channel_013 [02] IMOS MO13
hannel_014 [02] TMDS D14
Channel_015 [02] IMO7 MO1S
hannel_D16 [02] TMOB TNO1E
Channel_017 [03] IMO1 NO17
hannel_018 [03] TMODZ TNO1E
Metadata

Meta-information can be assigned to saved channels. Previously, this function was only available for
the channels on the PC hard drive. Now, the information is also saved in the channels on the device
hard drive.

Trigger

The pretrigger is defined for channels which are assigned to a defined trigger. Channels without such a
trigger assignment, in other words, which are started directly when the measurement is started, are
assigned to the symbolic special trigger "Trigger_48". If one deleted a trigger assignment for a
channel, which is the same as assigning the channel to "Trigger_48", it had been necessary to also
manually delete an old pretrigger-setting under "Trigger_48". This is now no longer necessary; the
pretrigger is deleted automatically.

imc Online FAMOS

o |f code without control commands exists in the imc Online FAMOS Editor, and if the option
"imc Online FAMOS with Control Commands" is activated, then the existing code is automatically
analyzed and expanded. To correspond with the trigger-assignments of the channels used, the
individual lines of code are automatically assigned to the appropriate segments (structures).

¢ Further, when pasting existing codes from the clipboard into the empty editor, the system
automatically recognizes whether it contains control commands. If so, the option
"imc Online FAMOS with Control Commands" is automatically activated if necessary.
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¢ To prevent signal jumps on a DAC output channel, during the download phase the system checks
whether a DAC output channel is initialized in the "OnlInitAll" block within the OFA-code. If so, this
value is used and any previously set value from the datapool (e.g. via a Widget) is ignored.

Channel Name Assistant

For the purpose of changing multiple channel names, the "Channel Name Assistant™ is provided. It has
been completely revised and redesigned.

Preview @

Point_of_measurement_»A_01
Point_of_measurement_A_02
Point_of_measurement_A&_03

Static text b

Static text | Point_of_measurement_ [

Alphabetic i3

Initial value: | A | Max value: [ € | step size: | 1 | overflow | Rotate =|

Static text b

Static text | _ I

Mumeric b 4

Initial value; | 1 Max Value: | 3 Step size: | 1 Overflow | Rotats n| Number of digits: 2

Format item options

| % Deleteall | | . Editlists | |Static text 1 | - Add Static text item

Format options

. Edit formats Last used |S-avad Format? | Point_of_measurement_A_01, Point_of_measurement_& 02, Point_of_meas n|

ok || cancal |
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Supplemental files

e The new "Supplemental files"-dialog makes it possible to manage all imported supplemental files
across various devices. In consequence, it is possible to quickly recognize which files are assigned to
which devices. You can also open and edit the files form within the dialog with the associated
standard program.

Supplemental files X
, j Show experiment name

Import

File View

¥ T_126675 C5 7008 1
Charact.dat
Devl01l.msg

e In order to make it easy to use supplemental files from multiple devices, it is now possible to select
multiple devices upon importing. In this way, all devices selected receive the same supplemental
file.

Default Values

Pre-set "Default Values" are now also applied to virtual and field-bus channels. Previously, they were
used just once when a device was selected.

Charge - Reset

Connector: ACC/DSUB-Q2:
The action: "Reset" can now also be executed when AC-coupling is set.

New dialog for configuring the devices’ interfaces

If no new devices are found by means of the device search, the new dialog for configuring device
interfaces can be opened. This dialog can additionally be manually accessed from the menu ribbon
(Setup-Configuration > Device interfaces). The predecessor program "imc DEVICES Interface
Configuration" can be called via the new dialog’s button "Advanced Configuration".

Devices which are not configured appropriately for the PC are listed under "Currently not reachable™.
For these, a configuration suggestion is automatically provided, which can be implemented in the
device by selecting "Apply".

Once the configurations are applied, the device is displayed under "Recently reconfigured" to ensure a
clear overview even when many devices are present. Additionally, all other devices are displayed
under "Ready for measurement".
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4 Panel

Variables for resource consumption

The Variables-class of the system information has been expanded. Previously, this class could be used
to query the status of the data storage media in the device or of the PC hard drives, for example. Now
these variables can also be used to get the current process information. In this way, you can supervise
imc STUDIO's resource consumption.

This information will provide a timely notification of when the storage medium will be full, for
example. Or, for measurements of long duration, the system's resource consumption can be regularly
monitored to ensure that the remaining available resources are still adequate for continued
operation.

Revised context menu

e The context menu of the Panel page tabs features a new structure, and a quick way to created
pages in a targeted manner.
= Pagi

Mew Page i’ Report (Portraik)
'-{ﬂ Imnport Page ... —
41 FReport (Landscape)
Export Page [ .
9 Show Page on Monitor — » ﬁ Dialog
*,  Zoom o | Dialog2x2
Page Options [
Dialog 2 x 1
Ch copy
E Dialog 1 x 2
a Celete E Cialog 7= 7
Rename

e By means of the context menu for variables in the Data Browser, it is possible to display the
selected variables in free-floating curve windows or in the "Current Values"window.
Skin
Prior to saving a new skin, a new preview is now always available. This makes it easier to check the
result in advance. The old menu items "Preview" and "Save As" have been combined.

Measurement name in the title

For the source of the displayed title, there is a new available selection: "Long Name". When "Long
Name" is selected, then along with the channel name, the respective measurement name is also
displayed. If the Widget is linked with a variable via a measurement number, the title displayed adapts
to the measurement selected.

5 4 3 2 -1 0

bl

Channel_00 5-04-17 12-14-13 (1
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Widget and page repository

e The possibilities for adding Widgets or complete pages to the respective repository have been
extended. For instance, it is conveniently possible to place items in the repository via the associated
context menu.

Copy Chrl+C

Ei

¢ Cut Chrl43

ﬁ Delete Delete
Arangernent F
Graup k
Dok, 3

Inko the repositary
= Properties
e If the name of a saved page is edited in the repository, then when that page is retrieved from the
repository, its name reflects the change accordingly.

¢ The default folder for the repository (root directory) has been relocated accordingly.
%HOMEPATH%\Documents\imc\imc STUDIO\PanelPages
%HOMEPATH%\Documents\imc\imc STUDIO\Widgets

New option: Panel > Panel Widgets > Widget configuration > Refresh rate of newly created Widgets

Specifies the refresh rate of Widgets which are newly created. If a Widget is created on a Panel page,
it is assigned the refresh rate set here.

Auxiliary variables - All connected variables are described

If a Widget is linked with multiple variables by means of the function "Auxiliary variables", all
connected variables receive a new value when the Widget is operated.

4.1 Widgets

Curve window

¢ An Internet-Map can be used as the curve background, which updates according to the GPS-data
displayed.
e The curve window toolbar can be activated/deactivated via the context menu.

¢ Inimc DEVICES experiments, free-floating curve windows are used to view the measured data. In
order that the curve window configurations not be lost when importing to imc STUDIO, the curve
windows are also displayed in imc STUDIO. You can save the configuration of these curve windows
and load them again into curve windows on the Panel pages. Thus, the configurations are also
available in imc STUDIO.

¢ Level indicator: For channels having a measurement range, a level indicator has been implemented.
This level indicator represents the current reading's distance from the measurement range as a bar.
The display range of the respective channel displayed automatically adjusts to the measurement
range set.
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Widgets: Automotive, Industrial, Designer
Tables

¢ There is now an option for deactivating the changing of the columns' sequential order. This
prevents unintended changing of the sequential order by accidental mouse-click over the title
column.

¢ For user-defined channels, you can insert an additional measured value ("sample") before or after

an existing value.
F

Ky Channel F
—
46
34

27
Copy value; 22

[

Paste wvalue;

Insert sample before

& B

Insert sample after

W Delete sample

e Properties such as zones, which previously could only be set for each cell individually can now be
defined for the entire column or table.

¢ Atable's number of columns and rows can be automatically adapted to the channel linked. To do
this, activate the new property "Automatic row count". To ensure that newly added cells have the
same properties as the other cells, define these properties for the entire column/table.

¢ The background of the tables belonging to the groups "Automotive" and "Industrial” can no longer
be set to Transparent. In this case, you should always use the Designer table.

Map

An enhancement of the curve window map makes it possible to display GPS-data and routes in an
independent widget. The map is loaded from the Internet in accordance with the position displayed.

Standard meter

For the Standard meter, colored rings representing the zones have been implemented. In a similar
way to the Potentiometer, this makes it possible to better accentuate the zones.

Bar graph

The value "0" is now the midpoint of the bar graph and no longer the range minimum, as previously.
The midpoint can still be defined as desired and the pointer deflects from there in the respective
direction as appropriate.
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Input, Output > Text
The text-Widget is now able to display complex variables (e.g. the system-variables).
Input, Output > Numeric with slider

The midpoint has been implemented as for the Bar graph. The slider starts at 0 and from there
deflects in the respective direction appropriate. Here, too, the midpoint can be arbitrarily defined as
desired.

Input, Output > DIO
For binary-, octal- or hex-representation, the maximum bit count has been increased. Doubles are
represented with up to 50 bits, Floats with up to 22 bits (7 decimal places).

Input, Output > List

Using the List, text-variables can be assigned user-defined texts. The selection list can now also be
filed with texts as well as with numbers.

Nzones TP
File Edit Options
@ AB =3 | Decimal places |2 - i L
Set Value Texk Color
b Yalue & Text & 1 Transparent
Yalue B Text B = Limeisreen
Yalue Text C | DodgerBlue l Title TextC v I
Yalue D Text D =] Red Text A
TextB
Tlew R @ Cancel TEXt C
Delete Raw &l oK TextD
A

Graphical switch
The control can be rotated. The angle can be set either to a fixed value or to depend on a variable.

yme
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Clock

By default, clocks display the PC time. But they can also display different times, subject to the
variables connected.

Variable: Analog channel

Property: Time displayed
Representation
Standard the channel’s current measurement duration (matches "duration™)
Start time the channel’s starting time
Duration the channel’s current measurement duration
Current measurement | the channel’s current time (matches the device’s time while measurement is running)
time
Standard Widgets

CCV-file selection dialog

The filepath can now be set as variable by means of placeholders. For instance, the experiment folder
path could be set to always be used.

4.2 Navigation bar

Datacut - Sectioning the data stream

Measured data within a highlighted region in the curve window can be exported to the hard drive or
transferred to imc FAMOS. There are multiple settings available as the pre-configuration.

4.3 Data Browser

New option: Project Management > General options > Load measurements
If this option is activated, saved measurements in the Data Browser are displayed.

In the Data Browser, it is also possible to filter by meta-data

Once columns for saving the channels have been selected by means of the Metadata Assistant, these
columns can be added in the Data Browser. With the filter in the Data Browser,it is possible to select
these columns and to filter them according to entry.

Drag&Drop for variables has been improved

Using Drag&Drop, it is now possible to move variables not only to the Panel page. Drag&Drop applied
to variables from the Data Browser now also works for the following purposes:

Data Browser to the free-floating curve window

Data Browser to the file system in the Windows Explorer (only when saving of measured data is
activated)

Data Browser to the imc FAMOS Variables list (only when saving of measured data is activated)

Data Browser to the imc FAMOS Sequence Editor
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5 Commands

New functions

Command

Description

Browse in workspace

If the current view is to change over to the Panel, it can be started immediately in
fullscreen mode.

Browse in workspace -

Layout: | Panel
Page: Pansl [+ ]
Parameters: Panel Embedded Maede E

Panel Embedded Maode

[ ok || cancs

L

Email

In the address box and in the attachments, it is now possible to use placeholders.

Set measurement
number

Itis possible to delete the measurement number set from any measurement.

Data Saving Assistant

The command can be executed "silently”. If the box: "Execute without request” is
checkmarked, the command’s selected default action is always executed without requiring
confirmation from the user.

Export Variable

The option "Always overwrite existing files" has been added. If this option is activated, files
of the same name in the target folder are overwritten without a confirmation prompt.

Revised functions

Command

Description

IF, (While) Loop and
Switch

For commands, which evaluate the last dialog-response, the last response had previously
not be reset when the Sequencer was re-launched. Now, these commands no longer apply
the last response provided from the previous run of the Sequencer.

Export Variable

The option "Show dialog™ has been subdivided into the options: "Show file options" and
"Show variable options". In this way, some options can be protected.

Operation modified

Command

Description

Parameter set export

In the selection of variables, multi-selection had previously not been possible. Now, it is
possible to add multiple variables for export simultaneously.

Delete variable

In the selection of variables, multi-selection had previously not been possible. Now, it is
possible to add multiple variables for deletion simultaneously.

Data Saving Assistant

The operation of the checkbox: "Keep original files" has been revised to "Delete original

files". In saved experiments, the setting is correctly converted accordingly. If the box had
previously been checked (“Don’t delete original files”), then it is now empty (for "Delete
original files").
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6 Sequencer-Events

Storage_DirectoryUpdate

The event "Storage_DirectoryUpdate™ has been enhanced, so that additional information can be
imported from the event via Scripting. E.g about the storage location. See also Script type "Event-

Script”| 21,

User-defined events

It is now possible to open the event configuration by double-clicking.

7 Data Processing

Configuring results channels in the Setup

For quick and clearly organized configuration of the results channels belonging to Data Processing-
tasks, all results channels appear in the channel table in the main window: Setup. Here, the channels
can be configured like the virtual channels belonging to imc Online FAMOS.

Multiple calculation sequences

Multiple independent, complete calculation sequences (Tasks) can be performed in parallel. Even
ones of the same type. The calculations for the various tasks are automatically distributed to the
different cores of a multi-core system. This evens out and improves the distribution of the demands
for computational resources.

7.1 imc Inline FAMOS

Processing and analysis of measured data during a running measurement
imc Inline FAMOS is a functions package for Data Processing.

imc Inline FAMOS enables calculations to be performed on data streams from the measurement
currently runnning. The calculations are performed on the PC, taking advantage of the PC's processing
power. By contrast, with imc Online FAMOS, the calculations are performed by the device.

Scope of functions:

A number of pre-defined functions are available for calculation purposes. Most of the
imc Online FAMOS functions are available in the same way and with the same syntax as in
imc Inline FAMOS. There are a few additional functions exclusively in imc Inline FAMOS.

Cross-device calculations

In contrast to imc Online FAMOS, imc Inline FAMOS provides the ability to apply calculation
operations to channels belonging to different devices, if the channels are assigned to Trigger_48
(measurement Start/Stop).

Displaying results:
The results generated are treated as device variables/channels. They are configured on the Setup
pages (e.g. Storage) and can be displayed on Panel pages.

Tasks:

Multiple independent, complete calculation sequences (Tasks) can be processed in parallel. The
maximum possible scope/amount of these tasks depends on the computational resources required by
the functions used, in conjunction with the computational resources available to the PC used.
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License:

A license must be purchased in order to use imc Inline FAMOS. In contrast to imc Online FAMOS, this
license is not bound to the device used, but rather to the imc STUDIO installation on the PC.

Comparison: imc Online FAMOS / imc Inline FAMOS

imc Online FAMOS imc Inline FAMOS
Device-based, classical real-time analysis PC-based analysis of live streaming data

diametrically different from imc FAMOS (post-processing
of completed data sets)

Processing occurs where the data are captured, inside of | Processing occurs on the PC, and not where the data are

the measurement device captured.

¢ no calculations across multiple devices possible e Calculations across multiple devices possible (applies

e stand-alone capability to all channels which are captured as of measurement
start (Trigger 48) ), optionally also of 3rd-party devices
(via 3PDI)

¢ not stand-alone capable
¢ correspondingly reduced real-time reaction

e conversely: use of the powerful and scalable
PC-platform

Resolution of the calculations and results: 4 byte Resolution of the calculations and results: 8 byte
Commonalities:

e Live-analysis: immediate visual feedback

e Processing of live data streams: running, not concluded, measurements (not post-processing)

¢ Unified syntax, same scope of functions

¢ Application of calculation operations to combinations of multiple channels assigned to the same trigger

7.2 Powertrain Monitoring

The component imc STUDIO Powertrain Monitoring has been developed in close cooperation with GfM
(Gesellschaft fir Maschinendiagnose mbH) company, experts in machine and bearing diagnostics.

It is dedicated to diagnosis of powertrains. The powertrains can consist of motors, shift gearboxes and
engines as well as devices for braking. The diagnosis can be used in field scenarios, test plants or end of
line tests in a production.

Powertrain Monitoring offers two different kinds of diagnosis of vibrations: a base diagnosis on the basis
of characteristic values and a Advanced Diagnosis on the basis of a frequency selective search of
kinematic pattern.

A configuration for a specific gear type is created in the imc STUDIO project, from where it can be
distributed to different test stations. In the actual application within the experiment, the inputs are
assigned to the physical measurement channels according to the configuration selected. This system
allows to use the same configuration on different measurement systems if multiple test locations are
driven with the same powertrain type.

For Powertrain Monitoring, an extra license is required, which is available from imc MeRRsysteme GmbH.
It can be combined and operated with various basic editions of imc STUDIO.
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7.3 Bus Decoder

Expansion package for decoding Field-bus log channels
imc STUDIO BusDecoder is a package of functions for Data Processing.

This plug-in allows either all or individual measurement channels belonging to a log-channel to be
decoded/extracted. A log-channel can be a logged Field-bus communication ("Logfile").

The decoding information which is usually located in separate configuration files (e.g. with CAN in *.dcb)
is instead in embedded in the log channel. Thus, the log channel contains all information necessary for
decoding. This provides more flexibility and dynamic capability for deciding on targeted extraction of
individual channels from the compressed logfile.

The decoding is performed on the basis of the data streams of the measurement currently running on the
PC. This utilizes the PC's computation resources.

The following functions are available:
¢ Decoding of either all or individual channels from a log-channel
¢ Resampling of the channels

¢ Saving of the result channels

The results generated can be displayed on Panel pages and saved with the associated measurement data.
Subsequent processing by means of imc Inline FAMOS is also possible.

The following bus systems are supported:
e CAN
e SPI
e MVB (restricted)

8 Scripting

Revised functions
A Panel-script is now executed/stopped when the Panel page is entered/exited. Previously, this
happened when the Design-mode was activated/deactivated.

New functions

e The class "ParameterValues" has been extended.

¢ The script type "Event-script” can be used for events which return additional information. In this
way, information can be evaluated and reacted upon via the script. This has previously only been
possible with the event "Storage_DirectoryUpdate", which returns such information as the storage
location of completed measurements.

e Two more methods "PanelScriptinitialize” and "PanelScriptDispose” were added to the Panel script
to simplify the use of Windows-Forms.
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Operations modified
e The menu in the "Scripts” tool window has been revised.
¢ The tool window "Scripts" now has a context menu.

e The terms "Save as/Script storage" and "Script scope" were changed to "Storage scope™ and
"Activity scope" geandert.

Exporting/importing script:

o Multiple scripts can be exported/imported simultaneously. Multi-selection of scripts had
previously not been possible.

o For scripts which are imported, the Storage scope can be changed.

¢ Binary export/import (*.dll) of scripts is now possible.

Scripts can be ordered by name in the tool window.

Scripts are ordered alphabetically in the command "Run script".
Double-clicking on a script causes it to be opened in the Script-Editor.

9 Third Party Device Interface

Using the plug-in imc STUDIO Third Party Device Interface,it is possible to integrate devices from other
manufacturers (3rd-party devices) into imc STUDIO and run them in the imc STUDIO system.

For this purpose, a C#-script is implemented which models the 3rd-party device’s properties. There is a
template which simplifies the process of seamlessly integrating the 3rd-party device and its channels into
the existing settings menus and setup tables. In particular, this means that these devices/channels
appear in the lists of devices and channels in the imc STUDIO Setup. This thus provides uniform operation
style and configuration management. The script must additionally implement the interface to the 3rd-
party device in the sense of a data driver.

The plug-in 3PDI is specially suited to enhancing a system configuration consisting of imc hardware with
supplemental specialty devices and data sources. However, there is also a license available specifically for
operation exclusively with 3rd-party devices, without the use of any imc devices.

Besides the developer framework and the licenses to run one’s own self-provided scripts, ready-made
implementations are also available for purchase.

All runtime licenses (for running 3PDI scripts) can categorically be operated with any edition of
imc STUDIO.

To provide an overview, there is a 3rd-party device assistant, which manages the 3rd-party scripts. A
license is required for executing 3rd-party scripts (at runtime). It can be operated/used with various
standard editions of imc STUDIO.
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A number of standard devices is already supported for this purpose and is available for selection via the
Assistant:

Device Description

AudioDevice With the 3rd-party script "AudioDevice", it is possible to the computer's audio devices
(such as the microphone input) as a data source.

ChannelLoader The "ChannelLoader"-script enables files in the imc-format to be played back as a signal

during a measurement.

FunctionSimulator The template "FunctionSimulator" makes various signal types (sine, cosine, trapezoid,
square wave, ...).

SimplePollDevice and | These 3rd-party scripts are executable templates and can be expanded accordingly.
SimplePushDevice

AgilentinfniiVision Integrates digital oscilloscopes, namely of the series Agilent InfiniiVision DSO 6014L.
DSCO6014L (Digital Requires separate expansion license "imc STUDIO 3PDI-DigitalScope".

Scope)
fosdx Supports devices of the manufacturer fos4x for measurements with fiber-optic sensors and
optical strain gauges (Fibre Bragg, FBG). Requires a separate expansion license "imc
STUDIO 3PDI-fos4x".

10 Monitor

Placeholder EXPERIMENT.PATH

The placeholder EXPERIMENT.PATH can now also be used in imc STUDIO Monitor, in order to find the
path to the experiment file.

Activate/deactivate saving

Activation/deactivation of data storage in imc STUDIO Monitor has been enabled as a menu action.
Thus, data storage can be controlled by a button on a Panel page , via the menu ribbon, or by means
of the command: Execute menu action.

11 Video

Video codec "H.264"
The video codec H.264 from Leadtools is now supported.

12 Update Notes

12.1 SQL Placeholder
Such SQL placeholders used as: SETUP.SQL, EXPERIMENT.SQL, MEASUREMENT.SQL may need to be
converted manually. The associated information is always outputted when an old experiment is loaded.
Background:

Column identifier with spaces in the name could not be resolved. In order to make this possible, the
syntax needed to be revised. Column identifier are now always expected in apostrophes (* '). Old, saved
placeholders (without the appropriate brackets) may in some cases fail to be resolved.

Correction:

If an SQL-placeholder is not resolved correctly, navigate to the position where the placeholder is used.
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¢ Select the "green" text with the cursor
L]

<SETUP.SULMSELECT DefcriptionLong FROM Project™)>
@

o Press the keys: <CTRL> + <Space>

¢ In the Assistant which opens consequently, the corrected syntax already appears. Simply click on
the button: OK

[ ——— #
Tables Columns Condition

Analog and digital chani= Company name 2 And
Analog channels

AppMod block paramete | | Conditions (end)

Channels Conditions parameter r—

Channels (Balance, Sht_| | oo itions parameter r
Current time

Dependencies Conditions parameter v

Devices Conditions parameter v
Digital channels Date

Diskstart configurations
eriment
- b | 1| | ]

SELECT 'DescriptionLong’ FROM [Project] 0K

The automatically corrected syntax is used:

&

12.2 imc Applikations-Modul - ExternalEditor

"If a dedicated "ExternalEditor" was written for an application, it needs to be revised upon updating to
imc STUDIO 5.0R3.

In the class inherited from API_ReturnValue V1, the following lines of code must be appended:

//new in the inc STUDI O 5. 0R3 Version

public APl _Vx Get APl <API _Vx>() where API_Vx : class, |ReturnVal ueBase
{

}

return this as APl _Vx;
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In total, this would appear as follows:

cl ass ChangedAppMbdZip : APl _ReturnVal ue_V1
{
public inc. Comon. | nterfaces. Loghook. APl _LogbookEntry VA[] Error

get { return new int. Common. I nterfaces. Logbook. APl _LoghookEntry VI[1{}; }
public bool HasChanges
{

}

public bool HasErrors
{

get { return true; }

get { return false; }

//newin the inc STUDIO 5.0R3 Version
public APl _Vx Get APl <API _Vx>() where API_Vx : class, |ReturnVal ueBase

{
}

return this as APl _Vx;
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